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This is a legal agreement between you, the end user, and Microsoft Corporation, a Delaware, U.S.A. corporation (“Microsoft”). BY OPENING THE
SEALED DISK PACKAGE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS
OF THIS AGREEMENT, PROMPTLY RETURN THE UNOPENED DISK PACKAGE AND THE ACCOMPANYING ITEMS (including written materials
and binders or other containers) TO THE PLACE YOU OBTAINED THEM FOR A FULL REFUND.

. GRANT OF LICENSE — This Microsoft License Agreement (*License") permits you to use one copy of the Microsoft software product acquired with this

License (“SOFTWARE") on any single computer, provided the SOFTWARE is in use on only one computer at any time. If you have multiple Licenses for
the SOFTWARE, then at any time you may have as many copies of the SOFTWARE in use as you have Licenses. The SOFTWARE is “in use” on a
computer when it is loaded into the temporary memory (i.e. RAM) or installed into the permanent memory (e.g. hard disk, CD ROM, or other storage
device) of that computer, except that a copy installed on a network server for the sole purpose of distribution to other computers is not “in use”. If the
anticipated number of users of the SOFTWARE will exceed the number of applicable Licenses, then you must have a reasonable mechanism or process in
place to assure that the number of persons using the SOFTWARE concurrently does not exceed the number of Licenses. Any teacher who uses the
SOFTWARE in a classroom setting may also use the SOFTWARE on their home computer for lesson planning purposes.

. COPYRIGHT — The SOFTWARE is owned by Microsoft or its suppliers and is protected by United States copyright laws, international treaty provisions,

and all other applicable national laws. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g., a book) except that if the
software is not copy protected you may either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or (b) transfer the
SOFTWARE to a single hard disk provided you keep the original solely for backup or archival purposes. You may not copy the Product manual(s) or
written materials accompanying the SOFTWARE.

OTHER RESTRICTIONS — You may not rent or lease the SOFTWARE, but you may transfer your rights under this Microsoft License Agreement on a
permanent basis provided you transfer all copies of the SOFTWARE and all written materials, and the recipient agrees to the terms of this Agreement.
You may not reverse engineer, decompile or disassemble the SOFTWARE. Any transfer must include the most recent update and all prior versions.

Please see the warranty information at the end of the Windows section of this booklet.



Turn on your computer and @ Sbcj’ 1
computer screen. If you're
not sure how, ask for help.

Hi 1 McZoee™ here.
Fust follow et

If you have a button like this
on your keyboard, press it.

Or if you have buttons
like this, press |



Sbef 2, @ Put Disk 1 in the disk drive.

Not:

If you have virus detectors
or startup programs, they
can interfere with Setup.
Before you start Setup:

For System 7™ users:
Restart your computer while
holding down the Shift key.

For System 6 users:

I. Open the System folder
(click it twice).

2. Move the icon(s) for the
virus detector(s) out onto
the Desktop.

3. Restart your computer.



You'll see this icon. @ Sbef 3

Setup

Click it twice really fast
(double-click).

You're on your way. @ Stﬁf’ T

' Just follow the directions
Corvoalt on the screen. I'll tell
.,('rr.cab ; you when it’s time to
put in the next disk.

N ob«¢:

To put back your
virus software:

For System 7 users:
Restart your
computer.

For System 6 users:
Drag the virus
detector(s) back
into the System
folder, then restart
your computer.




® Hot tips
To:

Do this:

Start Creative Writer

Start Fine Artist

To get help in
Creative Writer
or Fine Artist

Double-click

Creative Writer

Double-click

Fine Artist

Click me, McZee! If you
don’t see me, look for me
in the Flying Carpet Bag.

=)

s

Hold down 88 and press Q.



Questioris @
What if | have trouble putting Creative Writer or Fine Artist on
my computer?

* Sometimes programs that start whenever you turn on your Macintosh can
cause problems when you try to set up Creative Writer or Fine Artist.
Try removing these programs from your System folder before you set up
Creative Writer or Fine Artist. Follow the steps for removing virus detec-
tors near the beginning of this booklet. After you've set up Creative Writer
or Fine Artist, you can put them back.

If you have System 7, try holding down the Shift key when you turn on
your computer.

What if my document doesn’t print?

* Make sure your printer is turned on. Plug the printer into your computer
and into a power outlet. Turn on the printer’s power switch. If you need
more help, see your printer’s manual.

* Make sure there is paper in the printer. Make sure the paper isn’t jammed in
the printer.

* Check your printer cable to see if there are any loose connections to either
the computer or printer.

* Make sure the printer is “on line.” Most printers have an
On Line button with a light next to it. If the light is not on, press the On Line
button. If your printer doesn’t have an On Line button or light,
check your printer’s manual for more information.

* Make sure your computer is correctly set up to print to
your printer. For more information, see your printer’s
manual. If you still can’t print, call your printer manufacturer.

What if the pictures or text are cut off when | print?

* If you're using a dot matrix printer (for example, an
ImageWriter®), make sure the paper is lined up
correctly. For more information, see your
printer’s manual.

* Most laser or ink jet printers (for example, a

/ StyleWriter®) cannot print to the edge of the page.
You need to leave a minimum margin area. For more

information, see your printer’s manual.




* If you're using Creative Writer, look at the document
on the screen. If any objects are cut off at the edges, ~
move them toward the middle of the page until you
can see everything. It's a good idea to leave
1.27 cm of white space around the
edges of your document.

If you’re using Fine Artist, don’t
enlarge the picture before you
print. This is one of the questions
McZee asks when you print.

If the printout is cut off at the
bottom, your printer may not have
enough memory to print all of your
picture. Simplify your document.
Try removing some of the pictures =34
or stickers.

Can | open a document from another program in
Creative Writer or Fine Artist?

Yes! In Creative Writer, you can open a Microsoft Word or Microsoft
Works document, or any other document saved as a Text file.
Most word processing programs let you save a document as a Text file.

In Fine Artist, you can open any PICT or MacPaint® document.

Can | open a Creative Writer or Fine Artist document
in another program?

Yes! If you have Creative Writer, you can save the document as a
Text file, then open it in another word processing program. When you save
a document as a Text file, you keep only text and lose most formatting.

To preserve more formatting, you can buy a special utility that saves
your document with words, pictures, and some formatting. For more
information, call DataViz Inc. at (203) 268-0030. Customers outside the
United States may contact local distributors and dealers for information
on DataViz Inc. products.

* If you have Fine Artist, you can save your document as a PICT file and
then open it in another paint program.

* For information on saving documents as Text or PICT files,
see the next section.

* To move files from the Mac to a PC, use these file name extensions:
.MAX (Creative Writer) or .MAG (Fine Artist).




Can | change Creative Writer or Fine Artist settings?

Once you've started Creative Writer or Fine Artist, you can change

settings using the Control Room menu bar.

I. To display the Control Room menu bar, hold down Shift+ 88 +A.

You'll see this menu bar.

. To:

Select:

Change the printer or
connect to a network

Set the sound volume for
your entire system

Save a document as a Text file
SO you can open it in another
program (Creative Writer only)

Save a document as a PICT file
SO you can open it in another
program (Fine Artist only)

Set printing options
Turn the program
sounds on or off

Decode a document in case
someone forgets the password
(Creative Writer only)

Reset the Splot machine
so that it shows only Max’s
entries (Creative Writer only)

Switch between applications

Chooser from
the @ menu.

Control Panels
from the ® menu. Then
double-click Sound.

Save As Text
from the File menu.

Save As PICT
from the File menu.

Printing Options
from the File menu.

Sound Control
from the Tools menu.

Decode Document
from the Tools menu.

Reset Splot Machine
from the Tools menu.

Note: If you're using
System 6, you may not
have this installed.




® Microsoft Suppert S¢rvices

Microsoft offers a variety of support options to help you get the most from
Creative Writer or Fine Artist. If you have a question about Creative Writer
or Fine Artist, first look in the printed documentation and online Help.

If you cannot find the answer, contact Microsoft Product Support.

When you call, you should be at your computer and have the Creative
Writer or Fine Artist documentation at hand. Be ready to give the following
information:

* The version number of the Microsoft product you are using

* The type of hardware you are using

* The operating system you are using

* The exact wording of any messages that appeared on your screen

* What happened and what you were doing when the problem occurred
* How you tried to solve the problem

Within the United States you can get
product support in several ways:

Call Microsoft Product
Support Services

You can reach Microsoft Product
Support Services between 6:00 S
A.M. and 6:00 P.M. Pacific time, T
Monday through Friday. For “
assistance with Creative
Writer or Fine Artist, dial
(206) 635-7140.

Microsoft Telephone
Support for the Hearing
Impaired

Using a special TDD/TT
modem, dial (206) 635-4948.
Call between 6:00 A.M. and
6:00 P.M. Pacific time, Monday
through Friday.




Product Support Werldwid« @

To get information on how to get product support outside the United
States, contact Microsoft Product Support Services at the Microsoft
subsidiary office that serves your area. Microsoft subsidiary offices and

the countries they serve are listed in the following table.

For this country

Use this number

For this country

Use this number

Argentina
Australia
Austria
Baltic States

Belgium

Bermuda

Bolivia

Brazil

Canada
Caribbean Countries
Central America
Chile

Columbia
Denmark

Dubai

Eastern Europe
Ecuador

England

Finland

France

French Polynesia
Germany

Greece

Hong Kong

Ireland

Israel

(54)(1)814-0356
(61)(02)870-2131
0222 68 16 2710
see Germany

(Dutch) 02-5133274
(English) 02-5023432
(French) 02-5132268

see Venezuela
see Argentina
(55)(11)533-2922
| (416) 568-3503
see Venezuela
see Venezuela
5622185771
(571) 618 2255
(45)(44)89 01 00
(971) 4513 888
see Germany

see Venezuela
(44)(734)271000
(358)(0) 525 501
(33)(1) 69-86-10-20
see France
089-3176-0
(30)(1) 6896 663

(852) 804-4222
see England

972-3-575-7034

Italy

Japan

Korea
Liechtenstein

Luxembourg

Mexico

Netherlands

New Zealand
Northern Ireland
Norway

Papua New Guinea
Paraguay

Peru

Portugal

Puerto Rico
Republic of China
Republic of Ireland
Scotland

South Africa

Spain

Sweden

Switzerland

Uruguay
Venezuela

Wales

(39)(2) 269121
(81)(3)5454-8025

(82)(2) 563-9230

see Switzerland (German)

Dutch) (31) 2503-77877
English) (31) 2503-77853
French) (32) 2-5132268
52)(5) 325-0912

Dutch) 02503-77877
English) 02503-77853

64 (9) 357-5575
see England
(47)(2) 18 3500
see Australia

see Argentina
see Venezuela
(351) 1 4412205
see Venezuela
(886)(2)504-3188
see England

see England

(27) 11 444 0520
(34)(1) 803-9960
(46)(8) 752 68 50

(German) 01-839-61-11
(French) 022-738 96 88

see Argentina
0058.2.914739

see England

Microsoft’s support services are subject to Microsoft prices, terms,

and conditions in place at the time the service is used.




@ Licerise Warrafity itifortatiors

If you acquired your Microsoft ® Product in AUSTRALIA, NEW ZEALAND, or PAPUA NEW GUINEA, the following license
agreement applies to you:

LIMITED WARRANTY

To the full extent permitted by the Commonwealth, State, Territory or other law or laws applicable to this Agreement, any conditions or warranties
imposed by such legislation are hereby excluded. Insofar as liability under or pursuant to any legislation, whether of Commonwealth, State, Territory or
other government, may not be excluded, such liability is limited to:

(i) replacement of the SOFTWARE (and any accompanying hardware, if supplied by Microsoft); or,
(ii) correction of defects in the SOFTWARE

at the exclusive option of Microsoft.

You acknowledge that no promise, representation or warranty or undertaking has been made or given by Microsoft or any person or company on its
behalf in relation to the profitability of or any other consequences or benefits to be obtained from the delivery or use of the SOFTWARE and any
accompanying Microsoft supplied hardware, SOFTWARE manuals, and written materials. You have relied upon your own skill and judgment in deciding to
acquire the SOFTWARE and any accompanying hardware, SOFTWARE manuals, and written materials for use by you. This Agreement constitutes the
entire agreement and understanding between you and Microsoft in relation to the supply of SOFTWARE and any accompanying hardware, SOFTWARE
manuals, and written materials from Microsoft.

Except as and to the extent that it is hereinbefore provided, under no circumstances shall Microsoft or any related company be liable for any loss, damage
or injury (including without limitation any loss of profit, indirect, consequential or incidental loss, damage or injury) arising from the supply or use of the
SOFTWARE and any accompanying hardware and written materials or any failure by Microsoft or any related company to perform any obligation or
observe any terms of this Agreement.

This Agreement is governed by the laws of New South Wales, Australia.

Should you have any questions concerning this Agreement, or if you desire to contact Microsoft for any reason, please use the address information
enclosed in this product to contact the Microsoft subsidiary serving your country or write: Microsoft Customer Sales and Service, One Microsoft Way,
Redmond, Washington 98052-6399.

‘ If you acquired your Microsoft ® Product in CANADA, the following license agreement applies to you:
LIMITED WARRANTY

LIMITED WARRANTY — Microsoft warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying Product Manual(s)
for a period of 90 days from the date of
receipt; and (b) any Microsoft supplied
hardware accompanying the
SOFTWARE will be free from
defects in materials and
workmanship under normal use and
service for a period of one year
from the date of receipt. Any
implied warranties on the
SOFTWARE and hardware are
limited to 90 days and one (I) year,
respectively.

CUSTOMER REMEDIES —
Microsoft’s entire liability and your
exclusive remedy shall be, at
Microsoft’s option, either (a) return
of the price paid or (b) repair or
replacement of the SOFTWARE or
hardware that does not meet Microsoft’s
Limited Warranty and which is returned to
Microsoft with a copy of your receipt. This
Limited Warranty is void if failure of the
SOFTWARE or hardware has resulted
from accident, abuse, or
misapplication. Any replacement
SOFTWARE will be warranted for
the remainder of the original
warranty period or 30 days,
whichever is longer.

NO OTHER WARRANTIES —

MICROSOFT DISCLAIMS ALL OTHER

WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE, THE ACCOMPANYING PRODUCT MANUAL(S) AND WRITTEN
MATERIALS, AND ANY ACCOMPANYING HARDWARE. THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES — IN NO EVENT SHALL MICROSOFT OR ITS SUPPLIERS BE LIABLE FOR ANY OTHER
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THIS MICROSOFT
PRODUCT, EVEN IF MICROSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, MICROSOFT'S ENTIRE
LIABILITY UNDER ANY PROVISION OF THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR THE
SOFTWARE.

This Agreement is governed by the laws of the Province of Ontario, Canada. Each of the parties hereto irrevocably attorns to the jurisdiction of the
courts of the Province of Ontario and further agrees to commence any litigation which may arise hereunder in the courts located in the Judicial District of
York, Province of Ontario.

Should you have any questions concerning this Agreement, or if you desire to contact Microsoft for any reason, please use the address information
enclosed in this product to contact the Microsoft subsidiary serving your country or write: Microsoft Customer Sales and Service, One Microsoft Way,
Redmond, Washington 98052-6399.




Si vous avez acquis votre produit Microsoft® au CANADA, la garantie limitée suivante vous concerne :

GARANTIE LIMITEE — Microsoft garantit que (a) la performance du LOGICIEL sera substantiellement en conformité avec le(s) manuel(s) de produits qui
accompagne(nt) le LOGICIEL pour une période de quatre-vingt-dix (90) jours a compter de la date de réception ; et (b) tout matériel fourni par Microsoft
accompagnant le LOGICIEL sera exempt de défaut de matiére premiére ou de vice de fabrication dans des conditions normales d'utilisation et d'entretien

pour une période d'un an & compter de la date de réception. Toute garantie implicite concernant le LOGICIEL et le matériel est limitée a quatre-vingt-dix

(90) jours et un (1) an, respectivement.

RECOURS DU CLIENT — La seule obligation de Microsoft et votre recours exclusif seront, au choix de Microsoft, soit (a) le remboursement du prix
payé ou (b) la réparation ou le remplacement du LOGICIEL ou du matériel qui n'est pas conforme a la Garantie Limitée de Microsoft et qui est retourné a
Microsoft avec une copie de votre regu. Cette Garantie Limitée est nulle si le défaut du LOGICIEL ou du matériel est causé par un accident, un traitement
abusif ou une mauvaise application. Tout LOGICIEL de remplacement sera garanti pour le reste de la période de garantie initiale ou pour trente (30) jours,
selon laquelle de ces deux périodes est la plus longue.

AUCUNE AUTRE GARANTIE — MICROSOFT DESAVOUE TOUTE AUTRE GARANTIE, EXPRESSE OU IMPLICITE, Y COMPRIS MAIS NE SE
LIMITANT PAS AUX GARANTIES IMPLICITES DU CARACTERE ADEQUAT POUR LA COMMERCIALISATION OU UN USAGE PARTICULIER EN CE
QUI CONCERNE LE LOGICIEL, LE(S) MANUEL(S) DE PRODUITS, LA DOCUMENTATION ECRITE ET TOUT MATERIEL QUI LACCOMPAGNENT.
CETTE GARANTIE LIMITEE YVOUS ACCORDE DES DROITS JURIDIQUES SPECIFIQUES.

PAS D'OBLIGATION POUR LES DOMMAGES INDIRECTS — MICROSOFT OU SES FOURNISSEURS N'’AURONT D’OBLIGATION EN AUCUNE
CIRCONSTANCE POUR TOUT AUTRE DOMMAGE QUEL QU'IL SOIT (Y COMPRIS, SANS LIMITATION, LES DOMMAGES ENTRAINES PAR LA
PERTE DE BENEFICES, L'INTERRUPTION DES AFFAIRES, LA PERTE D'INFORMATION COMMERCIALE OU TOUTE AUTRE PERTE PECUNIAIRE)
DECOULANT DE L'UTILISATION OU DE L'IMPOSSIBILITE D'UTILISATION DE CE PRODUIT MICROSOFT, ET CE, MEME S| MICROSOFT A ETE
AVISE DE LA POSSIBILITE DE TELS DOMMAGES. EN TOUT CAS, LA SEULE OBLIGATION DE MICROSOFT EN VERTU DE TOUTE DISPOSITION
DE CETTE CONVENTION SE LIMITERA AU MONTANT EN FAIT PAYE PAR VOUS POUR LE LOGICIEL.

La présente Convention est régie par les lois de la province d'Ontario, Canada. Chacune des parties  la présente reconnait irrévocablement la
compétence des tribunaux de la province d’Ontario et consent a instituer tout litige qui pourrait découler de la présente auprés des tribunaux situés dans
le district judiciaire de York, province d'Ontario.

Au cas ou vous auriez des questions concernant cette licence ou que vous désiriez vous mettre en rapport avec Microsoft pour quelque raison que ce
soit, veuillez contacter la succursale Microsoft desservant votre pays, dont I'adresse est fournie dans ce produit, ou écrire a : Microsoft Customer Sales
and Service, One Microsoft Way, Redmond, Washington 98052-6399.

If you acquired your Microsoft ® Product in ENGLAND, SCOTLAND, WALES OR IRELAND, the following license agreement
applies to you:

LIMITED WARRANTY

LIMITED WARRANTY — Microsoft warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying Product Manual(s)
for a period of 90 days from the date of receipt; and (b) any Microsoft supplied hardware accompanying the SOFTWARE will be free from defects in
materials and workmanship under normal use and service for a period of one year from the date of receipt. Any implied warranties on the SOFTWARE
and hardware are limited to 90 days and one (I) year, respectively, or the shortest period permitted by applicable law, whichever is greater.

CUSTOMER REMEDIES — Microsoft’s entire liability and your exclusive remedy shall be, at Microsoft’s option, either (a) return of the price paid or (b)
repair or replacement of the SOFTWARE or hardware that does not meet Microsoft’s Limited Warranty and which is returned to Microsoft with a copy
of your receipt. This Limited Warranty is void if failure of the SOFTWARE or hardware has resulted from accident, abuse, or misapplication. Any
replacement SOFTWARE will be warranted for the remainder of the original warranty period or 30 days, whichever is longer.

NO OTHER WARRANTIES — TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MICROSOFT DISCLAIMS ALL OTHER
WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE, THE ACCOMPANYING PRODUCT MANUAL(S) AND WRITTEN
MATERIALS, AND ANY ACCOMPANYING HARDWARE. THE LIMITED WARRANTY CONTAINED HEREIN GIVES YOU SPECIFIC LEGAL RIGHTS.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES — TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MICROSOFT AND ITS
SUPPLIERS SHALL NOT BE LIABLE FOR ANY OTHER DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE
OF OR INABILITY TO USE THIS MICROSOFT PRODUCT, EVEN IF MICROSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
IN ANY CASE, MICROSOFT'S ENTIRE LIABILITY UNDER ANY PROVISION OF THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT
ACTUALLY PAID BY YOU FOR THE SOFTWARE.

This Agreement is governed by the laws of England.
Should you have any questions concerning this Agreement, or if you desire to contact Microsoft for any reason, please use the address information

enclosed in this product to contact the Microsoft subsidiary serving your country or write: Microsoft Customer Sales and Services, One Microsoft Way,
Redmond, Washington 98052- 6399.




@ ' you acquired your Microsoft @ Product in ANY OTHER COUNTRY, the following license agreement applies to you:
LIMITED WARRANTY

LIMITED WARRANTY —Microsoft warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying Product Manual(s)
for a period of 90 days from the date of receipt; and (b) any Microsoft supplied hardware accompanying the SOFTWARE will be free from defects in
materials and workmanship under normal use and service for a period of one year from the date of receipt. Any implied warranties on the SOFTWARE
and hardware are limited to 90 days and one (1) year, respectively, or the shortest period permitted by applicable law, whichever is greater.

CUSTOMER REMEDIES — Microsoft's entire liability and your exclusive remedy shall be, at Microsoft's option, either (a) return of the price paid or (b)
repair or replacement of the SOFTWARE or hardware that does not meet Microsoft’s Limited Warranty and which is returned to Microsoft with a copy
of your receipt. This Limited Warranty is void if failure of the SOFTWARE or hardware has resulted from accident, abuse, or misapplication. Any
replacement SOFTWARE will be warranted for the remainder of the original warranty period or 30 days, whichever is longer.

NO OTHER WARRANTIES — MICROSOFT DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE,
THE ACCOMPANYING PRODUCT MANUAL(S) AND WRITTEN MATERIALS, AND ANY ACCOMPANYING HARDWARE. THIS LIMITED
WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES — IN NO EVENT SHALL MICROSOFT OR ITS SUPPLIERS BE LIABLE FOR ANY OTHER
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS
OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THIS MICROSOFT
PRODUCT, EVEN IF MICROSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, MICROSOFT'S ENTIRE
LIABILITY UNDER ANY PROVISION OF THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR THE
SOFTWARE.

This Agreement is governed by the laws of the State of Washington, U.S.A.

Should you have any questions concerning this Agreement, or if you desire to contact Microsoft for any reason, please write: Microsoft Customer Sales
and Service, One Microsoft Way, Redmond, Washington 98052-6399.

® Copyright irifortiatior

Information in this document is subject to change without notice. Companies, names, and data used in examples herein are fictitious unless otherwise
noted. No part of this document may be reproduced or transmitted in any form or by any means, electronic or mechanical, for any purpose, without the
express written permission of Microsoft Corporation.

© 1993 Microsoft Corporation. All rights reserved. Printed in the United States of America.
Fine Artist was co-developed by Microsoft Corporation and Turning Point Software.
Joke and Riddle contributions created exclusively for Creative Writer and Fine Artist by Louis Phillips.

International CorrectSpell™ for Children licensed from Houghton Mifflin Company. Copyright © 1993 by Houghton Mifflin Company. All rights reserved.
Portions based on the American Heritage Children’s Dictionary. Reproduction or disassembly of embodied computer algorithms or database prohibited.

International Electronic Thesaurus for Children licensed from Houghton Mifflin Company. Copyright © 1993 by Houghton Mifflin Company. Al rights
reserved. Portions based on Roget's Il New Thesaurus. Reproduction or disassembly of embodied computer algorithms or database prohibited.

Lucida is a registered trademark of Bigelow & Holmes, Inc. Lucida® typefaces. Copyright © 1985, 1988, and 1990 by Bigelow & Holmes, Inc.
U.S. Patents Des 289, 420; Des 289, 421; Des 289, 422; Des 289, 773.

Creative Writer includes fonts from the Monotype Typeface Library.

Microsoft and the Microsoft logo are registered trademarks, and Windows and McZee are trademarks of Microsoft Corporation.

Apple is a registered servicemark; AppleTalk, ImageWriter, LaserWriter, StyleWriter, MultiFinder and Macintosh are registered trademarks; and Finder,
System 7, and TrueType are trademarks of Apple Computer Inc.

MacPaint is a registered trademark of Claris Corporation.
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This is a legal agreement between you, the end user, and Microsoft Corporation, a Delaware, U.S.A. corporation (“Microsoft”). BY OPENING THE
SEALED DISK PACKAGE, YOU ARE AGREEING TO BE BOUND BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS
OF THIS AGREEMENT, PROMPTLY RETURN THE UNOPENED DISK PACKAGE AND THE ACCOMPANYING ITEMS (including written materials
and binders or other containers) TO THE PLACE YOU OBTAINED THEM FOR A FULL REFUND.

1. GRANT OF LICENSE — This Microsoft License Agreement (“License”) permits you to use one copy of the Microsoft software product acquired with this
License (“SOFTWARE”) on any single computer, provided the SOFTWARE is in use on only one computer at any time. If you have multiple Licenses for
the SOFTWARE, then at any time you may have as many copies of the SOFTWARE in use as you have Licenses. The SOFTWARE is “in use” on a
computer when it is loaded into the temporary memory (i.e. RAM) or installed into the permanent memory (e.g. hard disk, CD ROM, or other storage
device) of that computer, except that a copy installed on a network server for the sole purpose of distribution to other computers is not “in use™. If the
anticipated number of users of the SOFTWARE will exceed the number of applicable Licenses, then you must have a reasonable mechanism or process in
place to assure that the number of persons using the SOFTWARE concurrently does not exceed the number of Licenses. Any teacher who uses the
SOFTWARE in a classroom setting may also use the SOFTWARE on their home computer for lesson planning purposes.

~

. COPYRIGHT — The SOFTWARE is owned by Microsoft or its suppliers and is protected by United States copyright laws, international treaty provisions,
and all other applicable national laws. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g., a book) except that if the
software is not copy protected you may either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or (b) transfer the
SOFTWARE to a single hard disk provided you keep the original solely for backup or archival purposes. You may not copy the Product manual(s) or
written materials accompanying the SOFTWARE.

3. OTHER RESTRICTIONS — You may not rent or lease the SOFTWARE, but you may transfer your rights under this Microsoft License Agreement on a

permanent basis provided you transfer all copies of the SOFTWARE and all written materials, and the recipient agrees to the terms of this Agreement.

You may not reverse engineer, decompile or disassemble the SOFTWARE. Any transfer must include the most recent update and all prior versions.

Please see the warranty information at the end of the Macintosh section of this booklet.



Turn on your computer and @ stﬁf 1
computer screen. If you're not
sure how, ask for help.

Hit McZee™ here.
Fust follow tnx?

If you have buttons
like this, press —




Step 2

If the Program Manager
window is open (something like
this), you're set. Go to step 3.

Program Manager
File Options Window Help

Or...if the Program Manager is
a little bitty picture, click the
picture twice really fast

(double-click).
The window opens. Cool!

Program
Manager

Or...if you see massive black-
ness, type win and press Enter.

This starts Microsoft Windows.

If the Program Manager
is a little bitty picture,
double-click it.

Phew b

Not¢:

Notb:

You may need to
quit any open
programs before you
put Creative Writer
or Fine Artist on
your computer.

The Program
Manager window
may be hidden
behind other
windows. To find it,
hold down Ctrl+Esc.
Then double-click
Program Manager.



Put Disk 1 into drive a, Stef 3
then close the door if necessary.

Not:

Which one is drive a?

W"O’W! If you only see one

slot, that's drive a.

If you see two slots,
drive a is usually the
one on the top or the
one all the way to
the left.

First, click File. Stgf ¥

You’ll see a list of choices.

Then click Run.



Then click OK.

Sbaﬁf’ 6 @ You're on your way. Just

follow the directions on the
screen. I'll tell you when it’s
time to put in the next disk.

Greatt




To:

Do this:

Start Creative Writer

Start Fine Artist

To get help in
Creative Writer
or Fine Artist

Quit

Double-click

Creative Writer

Double-click

Fine Artist

Click me, McZee! If you
don’t see me, look for me
in the Flying Carpet Bag.

® Hot tips




® Questions...

What if | don’t hear
any sound?

If you don’t have a sound
card, you won't hear
any sound.

Check the speaker volume. Make
sure the sound card or mixer is
turned up
as well.

Make sure the sound
board and sound
board software are
installed correctly. The
sound board may need to be
pressed more securely into its slot.

If you have both a sound board and special software that bypasses the
sound board to play sounds through the computer’s speaker, we suggest you
remove or disable the special software (the computer’s speaker driver).

If you have a Media Vision™ card (Pro Audio Spectrum), try updating
the driver.

What if the sound plays but is distorted?
The speaker volume may be set too high.

The volume control for your sound board may be set too high.

To change the sound board settings, check the manuals that came with your
sound board. You can usually change the volume using the sound board
volume dial (found at the back of your computer) or by using a program that
is often called a “mixer” (installed in the Windows Control Panel of the Main
program group). Some sound boards use both types of controls. In this case,
you should adjust both.

What if my document doesn’t print?

* Make sure your printer is turned on. Plug the printer into your computer and
into a power outlet. Turn on the printer’s power switch. If you need more
help, see your printer’s manual.

* Make sure there is paper in the printer. Make sure the paper isn’t jammed
in the printer.




* Check your printer cable to see if there are any loose connections to either
the computer or printer.

* Make sure the printer is “on line.” Most printers have an On Line button
with a light next to it. If the light is not on, press the On Line button. If your
printer doesn’t have an On Line button or light, check your printer’s manual
for more information.

* Make sure your computer is correctly set up in Windows to print to your
printer. Note: If you have more than one printer, Creative Writer and
Fine Artist print to the printer you selected in the Windows Control Panel.
For information about changing the default printer, see your Windows
documentation.

* If you still can’t print, check your printer manual or call your printer
manufacturer.

What if the pictures or text are cut off when | print?

* If you are using a dot matrix printer, make sure the paper is lined up
correctly. For more information, see your printer’s manual.

* Most laser printers cannot print to the edge of the page. You need to leave
a minimum margin area. For more information, see your printer’s manual.

* If you’re using Creative Writer, look at the document on the screen.

If any objects are cut off at the edges, move them toward the middle of the
page until you can see everything.
It's a good idea to leave .27 cm of
white space around the edges of
your document.

* If you are using Fine Artist, don’t
enlarge the picture before you
print. Note: This is one of the
questions McZee asks you when you
‘print.

* If the printout is cut off at the
bottom, your printer may not
have enough memory to print
all of your picture. Simplify
your document. For
example, try removing
some of the pictures

or stickers.




Can | open a document from another program in Creative Writer
or Fine Artist?

* Yes! In Creative Writer, you can open a Microsoft Word or Microsoft
Works document, or any other document you saved as a text file (.txt).
Note: Most word processing programs let you save a document as a text file.

* In Fine Artist, you can open any bitmap (.bmp) or Windows metafile (.wmf).
If you want to open a different document type, try opening the document
first in Microsoft Windows Paintbrush™, saving it as a bitmap (.bmp), then
opening it in Fine Artist.

Can | open a Creative Writer or Fine Artist document in
another program?

* Yes! If you have Creative Writer, you can save the document as a text file
(-txt) then open it in another word processing program. Note: When you
save a document as a text file, you keep only the text and lose most of
the formatting.

To preserve more formatting, you can buy a special utility that saves your
document with words, pictures, and some formatting. For more information,
call DataViz Inc. at (203) 268-0030. Customers outside the United States
may contact local distributors and dealers for information on

DataViz Inc. products.

* If you have Fine Artist, you can save your document as a bitmap (.bmp) and
then open it in another paint program.

* For information on saving documents as
text or bitmap files, see the next section.




Can | change Creative Writer or Fine Artist settings?

Once you've started Creative Writer or Fine Artist, you can change settings

using the Control Room menu bar.

1.To display the Control Room menu bar, hold down Shift+Ctrl+A.

You’ll see this menu bar.

Control Room

File Edit Tools

2.To:

Click:

Save a document as a text file (.txt)
SO you can open it in another program
(Creative Writer only)

Save a document as a bitmap (.bmp)
SO you can open it in another program
(Fine Artist only)

Change the printer or set print options

Turn the program sounds on or off

Decode a document in case
someone forgets the password
(Creative Writer only)

Reset the Splot machine
so that it shows only Max's
entries (Creative Writer only)

Note:

File, then click
Save As Text.

File, then click
Save As BMP.

File, then click
Printing Options.

Tools, then click
Sound Control.

Tools, then click
Decode Document.

Tools, then click
Reset Splot Machine.

* If you want to switch between programs, hold down Ctrl+Esc to display the
Windows Task List or hold down Alt+Tab to cycle through the programs.




® Microsoft Support Services

Microsoft offers a variety of support options to help you get the most from
Creative Writer or Fine Artist. If you have a question about Creative
Writer or Fine Artist, first look in the printed documentation and online
Help. If you cannot find the answer, contact Microsoft Product Support.

When you call, you should be at your computer and have the Creative
Writer or Fine Artist documentation at hand. Be ready to give the
following information:

* The version number of the Microsoft product you are using

* The type of hardware you are using

* The operating system you are using

* The exact wording of any messages that appeared on your screen

* What happened and what you were doing when the problem occurred
* How you tried to solve the problem

Within the United States you can get product support in several ways:

Call Microsoft Product
Support Services

You can reach Microsoft Product Support

Services between 6:00 A.M.

and 6:00 P.M. Pacific time, Monday

through Friday. For assistance with

Creative Writer or Fine Artist, AN

dial (206) 635-7140. i
-

Microsoft Telephone Support for
the Hearing Impaired

Using a special TDD/TT modem, dial
(206) 635-4948. Call between 6:00

A.M. and 6:00 P.M. Pacific time,
Monday through Friday.




Product Support Worldwide @

To get information on how to get product support outside the United States,
contact Microsoft Product Support Services at the Microsoft subsidiary office
that serves your area. Microsoft subsidiary offices and the countries they
serve are listed in the following table.

For this country

Use this number

For this country

Use this number

Argentina (54)(1)814-0356 Italy (39)(2) 269121

Australia (61)(02)870-2131 Japan (81)(3)5454-8025

Austria 022268 16 2710 Korea (82)(2) 563-9230

Baltic States see Germany Liechtenstein see Switzerland (German)

Belgium (Dutch) 02-5133274 Luxembourg (Dutch) (31) 2503-77877
(English) 02-5023432 (English) (31) 2503-77853
(French) 02-5132268 (French) (32) 2-5132268

Bermuda see Venezuela Mexico (52)(5) 325-0912

Bolivia see Argentina Netherlands (Dutch) 02503-77877

Brazil (55)(11)533-2922 (English) 02503-77853

Canada | (416) 568-3503 New Zealand 64 (9) 357-5575

Caribbean Countries

Central America

see Venezuela

see Venezuela

Northern Ireland

Norway

see England
(47)(2) 18 35 00

Chile 5622185771 Papua New Guinea see Australia
Columbia (571) 618 2255 Paraguay see Argentina
Denmark (45)(44)89 01 00 Peru see Venezuela
Dubai (971)4 513 888 Portugal (351) 1 4412205
Eastern Europe see Germany Puerto Rico see Venezuela

Ecuador see Venezuela Republic of China (886)(2)504-3188

England (44)(734)271000 Republic of Ireland see England

Finland (358)(0) 525 501 Scotland see England

France (33)(1) 69-86-10-20 South Africa (27) 11 444 0520

French Polynesia see France Spain (34)(1) 803-9960

Germany 089-3176-0 Sweden (46)(8) 752 68 50

Greece (30)(1) 6896 663 Switzerland (German) 01-839-61-11
(French) 022-738 96 88

Hong Kong (852) 804-4222 Uruguay see Argentina

Ireland see England Venezuela 0058.2.914739

Israel 972-3-575-7034 Wales see England

Microsoft’s support services are subject to Microsoft prices, terms,

and conditions in place at the time the service is used.




@ Licerise Warrarity ififortuatior

If you acquired your Microsoft ® Product in AUSTRALIA, NEW ZEALAND, or PAPUA NEW GUINEA, the following license
agreement applies to you:

LIMITED WARRANTY

To the full extent permitted by the Commonwealth, State, Territory or other law or laws applicable to this Agreement, any conditions or warranties
imposed by such legislation are hereby excluded. Insofar as liability under or pursuant to any legislation, whether of Commonwealth, State, Territory or
other government, may not be excluded, such liability is limited to:

(i) replacement of the SOFTWARE (and any accompanying hardware, if supplied by Microsoft); or,
(ii) correction of defects in the SOFTWARE

at the exclusive option of Microsoft.

You acknowledge that no promise, representation or warranty or undertaking has been made or given by Microsoft or any person or company on its
behalf in relation to the profitability of or any other consequences or benefits to be obtained from the delivery or use of the SOFTWARE and any
accompanying Microsoft supplied hardware, SOFTWARE manuals, and written materials. You have relied upon your own skill and judgment in deciding to
acquire the SOFTWARE and any accompanying hardware, SOFTWARE manuals, and written materials for use by you. This Agreement constitutes the
entire agreement and understanding between you and Microsoft in relation to the supply of SOFTWARE and any accompanying hardware, SOFTWARE
manuals, and written materials from Microsoft.

Except as and to the extent that it is hereinbefore provided, under no circumstances shall Microsoft or any related company be liable for any loss, damage
or injury (including without limitation any loss of profit, indirect, consequential or incidental loss, damage or injury) arising from the supply or use of the
SOFTWARE and any accompanying hardware and written materials or any failure by Microsoft or any related company to perform any obligation or
observe any terms of this Agreement.

This Agreement is governed by the laws of New South Wales, Australia.

Should you have any questions concerning this Agreement, or if you desire to contact Microsoft for any reason, please use the address information
enclosed in this product to contact the Microsoft subsidiary serving your country or write: Microsoft Customer Sales and Service, One Microsoft Way,
Redmond, Washington 98052-6399.

‘ If you acquired your Microsoft ® Product in CANADA, the following license agreement applies to you:
LIMITED WARRANTY

LIMITED WARRANTY — Microsoft warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying Product Manual(s)
for a period of 90 days from the date of receipt; and (b) any Microsoft supplied hardware accompanying the SOFTWARE will be free from defects in
materials and workmanship under normal use and service for a period of one year from the date of receipt. Any implied warranties on the SOFTWARE
and hardware are limited to 90 days and one (I) year, respectively.

CUSTOMER REMEDIES — Microsoft's entire liability and your exclusive remedy shall be, at Microsoft’s option, either (a) return of the price paid or (b)
repair or replacement of the SOFTWARE or hardware that does not meet Microsoft’s Limited Warranty and which is returned to Microsoft with a copy
of your receipt. This Limited Warranty is void if failure of the SOFTWARE or hardware has resulted from accident, abuse, or misapplication. Any
replacement SOFTWARE will be warranted for the remainder of the original warranty period or 30 days, whichever is longer.

NO OTHER WARRANTIES — MICROSOFT DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE
SOFTWARE, THE ACCOMPANYING PRODUCT MANUAL(S) AND WRITTEN MATERIALS, AND ANY ACCOMPANYING HARDWARE. THIS
LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES — IN NO EVENT SHALL MICROSOFT OR ITS SUPPLIERS BE LIABLE FOR ANY OTHER
DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION,
LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THIS MICROSOFT
PRODUCT, EVEN IF MICROSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, MICROSOFT'S ENTIRE
LIABILITY UNDER ANY PROVISION OF THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR THE
SOFTWARE.

This Agreement is governed by the laws of the Province of Ontario, Canada. Each of the parties hereto irrevocably attorns to the jurisdiction of the
courts of the Province of Ontario and further agrees to commence any litigation which may arise hereunder in the courts located in the Judicial District of
York, Province of Ontario.

Should you have any questions concerning this Agreement, or if you desire to contact Microsoft for any reason, please use the address information
enclosed in this product to contact the Microsoft subsidiary serving your country or write: Microsoft Customer Sales and Service, One Microsoft Way,
Redmond, Washington 98052-6399.




Si vous avez acquis votre produit Microsoft® au CANADA, la garantie limitée suivante vous concerne :

GARANTIE LIMITEE — Microsoft garantit que (a) la performance du LOGICIEL sera substantiellement en conformité avec le(s) manuel(s) de produits qui
accompagne(nt) le LOGICIEL pour une période de quatre-vingt-dix (90) jours 4 compter de la date de réception ; et (b) tout matériel fourni par Microsoft
accompagnant le LOGICIEL sera exempt de défaut de matiére premiére ou de vice de fabrication dans des conditions normales d'utilisation et d’entretien
pour une période d'un an & compter de la date de réception. Toute garantie implicite concernant le LOGICIEL et le matériel est limitée a quatre-vingt-dix
(90) jours et un (1) an, respectivement.

RECOURS DU CLIENT — La seule obligation de Microsoft et votre recours exclusif seront, au choix de Microsoft, soit (a) le remboursement du prix
payé ou (b) la réparation ou le remplacement du LOGICIEL ou du matériel qui n'est pas conforme 4 la Garantie Limitée de Microsoft et qui est retourné a
Microsoft avec une copie de votre recu. Cette Garantie Limitée est nulle si le défaut du LOGICIEL ou du matériel est causé par un accident, un traitement
abusif ou une mauvaise application. Tout LOGICIEL de remplacement sera garanti pour le reste de la période de garantie initiale ou pour trente (30) jours,
selon laquelle de ces deux périodes est la plus longue.

AUCUNE AUTRE GARANTIE — MICROSOFT DESAVOUE TOUTE AUTRE GARANTIE, EXPRESSE OU IMPLICITE, Y COMPRIS MAIS NE SE
LIMITANT PAS AUX GARANTIES IMPLICITES DU CARACTERE ADEQUAT POUR LA COMMERCIALISATION OU UN USAGE PARTICULIER EN CE
QUI CONCERNE LE LOGICIEL, LE(S) MANUEL(S) DE PRODUITS, LA DOCUMENTATION ECRITE ET TOUT MATERIEL QUI LACCOMPAGNENT.
CETTE GARANTIE LIMITEE VOUS ACCORDE DES DROITS JURIDIQUES SPECIFIQUES.

PAS D'OBLIGATION POUR LES DOMMAGES INDIRECTS — MICROSOFT OU SES FOURNISSEURS N'AURONT D’OBLIGATION EN AUCUNE
CIRCONSTANCE POUR TOUT AUTRE DOMMAGE QUEL QU'IL SOIT (Y COMPRIS, SANS LIMITATION, LES DOMMAGES ENTRAINES PAR LA
PERTE DE BENEFICES, L'INTERRUPTION DES AFFAIRES, LA PERTE D'INFORMATION COMMERCIALE OU TOUTE AUTRE PERTE PECUNIAIRE)
DECOULANT DE L'UTILISATION OU DE L'IMPOSSIBILITE D'UTILISATION DE CE PRODUIT MICROSOFT, ET CE, MEME S| MICROSOFT A ETE
AVISE DE LA POSSIBILITE DE TELS DOMMAGES. EN TOUT CAS, LA SEULE OBLIGATION DE MICROSOFT EN VERTU DE TOUTE DISPOSITION
DE CETTE CONVENTION SE LIMITERA AU MONTANT EN FAIT PAYE PAR VOUS POUR LE LOGICIEL.

La présente Convention est régie par les lois de la province d'Ontario, Canada. Chacune des parties a la présente reconnait irrévocablement la
compétence des tribunaux de la province d'Ontario et consent a instituer tout litige qui pourrait découler de la présente auprés des tribunaux situés dans
le district judiciaire de York, province d'Ontario.

Au cas ou vous auriez des questions concernant cette licence ou que vous désiriez vous mettre en rapport avec Microsoft pour quelque raison que ce soit,

veuillez contacter la succursale Microsoft desservant votre pays, dont I'adresse est fournie dans ce produit, ou écrire a : Microsoft Customer Sales and
Service, One Microsoft Way, Redmond, Washington 98052-6399.

If you acquired your Microsoft ® Product in ENGLAND, SCOTLAND, WALES OR IRELAND, the following license agreement applies
to you:

LIMITED WARRANTY

LIMITED WARRANTY — Microsoft warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying Product Manual(s)
for a period of 90 days from the date of receipt; and (b) any Microsoft supplied hardware accompanying the SOFTWARE will be free from defects in
materials and workmanship under normal use and service for a period of one year from the date of receipt. Any implied warranties on the SOFTWARE
and hardware are limited to 90 days and one (1) year, respectively, or the shortest period permitted by applicable law, whichever is greater.

CUSTOMER REMEDIES — Microsoft's entire liability and your exclusive remedy shall be, at Microsoft's option, either (a) return of the price paid or (b)
repair or replacement of the SOFTWARE or hardware that does not meet Microsoft's Limited Warranty and which is returned to Microsoft with a copy
of your receipt. This Limited Warranty is void if failure of the SOFTWARE or hardware has resulted from accident, abuse, or misapplication. Any
replacement SOFTWARE will be warranted for the remainder of the original warranty period or 30 days, whichever is longer.

NO OTHER WARRANTIES — TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MICROSOFT DISCLAIMS ALL OTHER
WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE, THE ACCOMPANYING PRODUCT MANUAL(S) AND WRITTEN
MATERIALS, AND ANY ACCOMPANYING HARDWARE. THE LIMITED WARRANTY CONTAINED HEREIN GIVES YOU SPECIFIC LEGAL RIGHTS.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES — TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, MICROSOFT AND ITS
SUPPLIERS SHALL NOT BE LIABLE FOR ANY OTHER DAMAGES WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF
BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE
OF OR INABILITY TO USE THIS MICROSOFT PRODUCT, EVEN IF MICROSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
IN ANY CASE, MICROSOFT'’S ENTIRE LIABILITY UNDER ANY PROVISION OF THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT
ACTUALLY PAID BY YOU FOR THE SOFTWARE.

This Agreement is governed by the laws of England.
Should you have any questions concerning this Agreement, or if you desire to contact Microsoft for any reason, please use the address information

enclosed in this product to contact the Microsoft subsidiary serving your country or write: Microsoft Customer Sales and Services, One Microsoft Way,
Redmond, Washington 98052- 6399.

@




If you acquired your Microsoft ® Product in ANY OTHER COUNTRY, the following license agreement applies to you:
LIMITED WARRANTY

LIMITED WARRANTY —Microsoft warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying Product Manual(s) for
a period of 90 days from the date of receipt; and (b) any Microsoft supplied hardware accompanying the SOFTWARE will be free from defects in materials
and workmanship under normal use and service for a period of one year from the date of receipt. Any implied warranties on the SOFTWARE and hardware
are limited to 90 days and one (1) year, respectively, or the shortest period permitted by applicable law, whichever is greater.
CUSTOMER REMEDIES — Microsoft's entire liability and your exclusive remedy shall be, at Microsoft’s option, either (a) return of the price paid or (b)
repair or replacement of the SOFTWARE or hardware that does not meet Microsoft’s Limited Warranty and which is returned to Microsoft with a copy of
your receipt. This Limited Warranty is void if failure of the SOFTWARE or hardware has resulted from accident, abuse, or misapplication. Any replacement
OFTWARE will be warranted for the remainder of the original warranty period or 30 days, whichever is longer.
NO OTHER WARRANTIES — MICROSOFT DISCLAIMS ALL OTHER WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
TO IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE, WITH RESPECT TO THE SOFTWARE, THE
ACCOMPANYING PRODUCT MANUAL(S) AND WRITTEN MATERIALS, AND ANY ACCOMPANYING HARDWARE. THIS LIMITED WARRANTY
GIVES YOU SPECIFIC LEGAL RIGHTS.
NO LIABILITY FOR CONSEQUENTIAL DAMAGES — IN NO EVENT SHALL MICROSOFT OR ITS SUPPLIERS BE LIABLE FOR ANY OTHER DAMAGES
WHATSOEVER (INCLUDING, WITHOUT LIMITATION, DAMAGES FOR LOSS OF BUSINESS PROFITS, BUSINESS INTERRUPTION, LOSS OF
BUSINESS INFORMATION, OR OTHER PECUNIARY LOSS) ARISING OUT OF THE USE OF OR INABILITY TO USE THIS MICROSOFT PRODUCT,
EVEN IF MICROSOFT HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. IN ANY CASE, MICROSOFT'S ENTIRE LIABILITY UNDER ANY
PROVISION OF THIS AGREEMENT SHALL BE LIMITED TO THE AMOUNT ACTUALLY PAID BY YOU FOR THE SOFTWARE.
This Agreement is governed by the laws of the State of Washington, U.S.A.

Should you have any questions concerning this Agreement, or if you desire to contact Microsoft for any reason, please write: Microsoft Customer Sales and
Service, One Microsoft Way, Redmond, Washington 98052-6399.
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